APPENDIX B –

Finalized Inflow Data Development
Section 1. Introduction

This report provides a detailed account of the inflow development for the OASIS Neuse River Basin Model. The inflow record runs from January 1930 to April 2008.\(^1\) This period is designed to capture as many drought events as possible, including the extreme droughts in the early 1930s and 2000s. There are 22 streamflow gages in the basin that are used in this project. These are listed in Table 1. These gages have at least 10 years of daily data with which to make valid statistical comparisons with other gages. None of these gages is tidally influenced. Most of the gages have incomplete records; they either started after 1930 or ended before 2008. Some of the gages were used just to provide more data for fill-in (see below) when computing statistics.

The inflow dataset is based on “unimpaired” gage flows. Gages only show the actual flow in the stream; they have no information about what the flow would have been without human intervention. “Impairments” are modifications of the natural flows due to change in reservoir storage (including evaporation and precipitation on the reservoir surface) and consumptive withdrawals of water (municipal, industrial, or agricultural). If water is withdrawn above a gage and returned to the river below the gage, the impairment is the entire withdrawal.

The next section describes the process used to compute daily flows and gains. Because of the noise in the data, it is important to look at the data at each step to find unrealistic values. These are noted later.

\(^1\) A provisional record extends through June 2009, but this does not account for most of the actual impairments. Future updates will require impairment data for the inflow dataset to be considered finalized.
Section 2. Data and General Procedure

The first step in building the record is to compute the unimpaired gage flows. These computations are contained in spreadsheets in the “Unimpairment of gage data” directory. The unimpaired gage data is summarized in the unimpaired.xls file. Impairments in the basin accumulate as each downstream gage is included. For example, the impairments upstream of Falls Lake include the impairments on the Eno River, Flat River, Knap of Reeds Creek, and Little River. The impairment is calculated as follows:

\[
\text{Unimpaired gage flow} = \text{gage flow} + \text{upstream water withdrawal (by agricultural, municipal, and industrial users)} - \text{upstream discharge (water or wastewater from municipal or industrial users, including power plants)} + \text{upstream change in reservoir storage} + \text{upstream evaporation precipitation on the reservoir surface} - \text{upstream precipitation on the reservoir surface}.
\]

The discharge and withdrawal data were obtained by Moffatt and Nichols. The data are based on monthly average demand for recent years, and extrapolated back to 1930 using population census data. The reservoir storage data were obtained from the operating utility. Records are available for most reservoirs, but only within the last five to ten years. Records for the largest reservoir, Falls Lake, are available from the Army Corp of Engineers (Corps) since project inception in 1981. Monthly storage data for Durham’s Lake Michie, which has been in operation for the entire period of record, was collected when available (1939 to present) by HydroLogics.

Evaporation and precipitation data were also collected by HydroLogics. Evaporation data are based on daily measurements from the Chapel Hill station, which is the only long-term station in the basin. When measurements are missing, the long-term monthly averages are used. Precipitation data are based on daily measurements from the following long-term stations: Butner Filter Plant, Chapel Hill 2W, Clayton WTP, Durham, Neuse 2 NE, RDU Airport, Raleigh 4 SW, NC State Univ Rocky Mount 6 SW, Rougemont, Roxboro 7 ESE, and Wilson 3 SW, as well as data from the Corps for Falls Lake. Data from the station closest to a reservoir are used to estimate the precipitation at the reservoir. When these data are missing, data from the next nearest station are used, and so on. For each reservoir, HydroLogics calculated a daily timeseries of net evaporation (or the difference between evaporation and precipitation) for the hydrologic record. These data are contained in spreadsheets in the “Evap-Precip” folder. These data are used to (1) estimate the historic change in reservoir storage due to net evaporation and (2) estimate net evaporation on the reservoir surface during OASIS model simulation.
<table>
<thead>
<tr>
<th>USGS Number</th>
<th>Description</th>
<th>Period of Record</th>
<th>Ref No.</th>
<th>Ref. Name</th>
<th>Drain. Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>02085000</td>
<td>Eno R. at Hillsborough</td>
<td>10/1927-9/1971, 10/1985-present</td>
<td>1</td>
<td>Hills</td>
<td>66</td>
</tr>
<tr>
<td>02085070</td>
<td>Eno R. nr. Durham</td>
<td>09/1963-present</td>
<td>2</td>
<td>Durha</td>
<td>141</td>
</tr>
<tr>
<td>0208521324</td>
<td>Little R. at SR1461 nr. Orange Factory</td>
<td>10/1987-present</td>
<td>3</td>
<td>Litor2</td>
<td>78.2</td>
</tr>
<tr>
<td>020852220</td>
<td>Little R. nr. Orange Factory</td>
<td>9/1961-9/1987</td>
<td>4</td>
<td>Litor1</td>
<td>80.4</td>
</tr>
<tr>
<td>0208524975</td>
<td>Little R. bl. Little R. Trib. at Fairintosh</td>
<td>10/1995-present</td>
<td>5</td>
<td>Litfa</td>
<td>98.9</td>
</tr>
<tr>
<td>02085500</td>
<td>Flat R. at Bahama</td>
<td>7/1925-present</td>
<td>6</td>
<td>Flatb</td>
<td>149</td>
</tr>
<tr>
<td>02087183</td>
<td>Neuse R. nr. Falls</td>
<td>7/1970-present</td>
<td>9</td>
<td>Falls</td>
<td>771</td>
</tr>
<tr>
<td>02087500</td>
<td>Neuse R. nr. Clayton</td>
<td>7/1927-present</td>
<td>10</td>
<td>Clayt</td>
<td>1150</td>
</tr>
<tr>
<td>02087580</td>
<td>Swift Ck. nr. Apex</td>
<td>3/2002-present</td>
<td>11</td>
<td>Swift</td>
<td>21</td>
</tr>
<tr>
<td>02088000</td>
<td>Middle Ck. nr. Clayton</td>
<td>10/1939-present</td>
<td>12</td>
<td>Middl</td>
<td>83.5</td>
</tr>
<tr>
<td>02088500</td>
<td>Little R. nr. Princeton</td>
<td>2/1930-present</td>
<td>13</td>
<td>Litpr</td>
<td>232</td>
</tr>
<tr>
<td>02089000</td>
<td>Neuse R. nr. Goldsboro</td>
<td>2/1930-present</td>
<td>14</td>
<td>Golds</td>
<td>2399</td>
</tr>
<tr>
<td>0208925200</td>
<td>Bear Ck. at Mays Store</td>
<td>10/1987-present</td>
<td>15</td>
<td>Beare</td>
<td>57.7</td>
</tr>
<tr>
<td>02089500</td>
<td>Neuse R. at Kinston</td>
<td>2/1930-present</td>
<td>16</td>
<td>Kinst</td>
<td>2692</td>
</tr>
<tr>
<td>02090380</td>
<td>Contentnea Ck. nr. Lucama</td>
<td>9/1964-present</td>
<td>17</td>
<td>Lucam</td>
<td>161</td>
</tr>
<tr>
<td>02091000</td>
<td>Nahunta Sw. nr. Shine</td>
<td>4/1954-present</td>
<td>18</td>
<td>Nahun</td>
<td>80.4</td>
</tr>
<tr>
<td>02091500</td>
<td>Contentnea Ck. nr. Hookerton</td>
<td>12/1928-present</td>
<td>19</td>
<td>Hooke</td>
<td>733</td>
</tr>
<tr>
<td>02091700</td>
<td>Little Contentnea Ck. nr Farmville</td>
<td>10/1956-9/1987</td>
<td>20</td>
<td>Ltcon</td>
<td>93.3</td>
</tr>
<tr>
<td>02092000</td>
<td>Swift Ck. nr. Vanceboro</td>
<td>2/1950-10/1989</td>
<td>21</td>
<td>Vance</td>
<td>182</td>
</tr>
<tr>
<td>02092500</td>
<td>Trent R. nr. Trenton</td>
<td>1/1951-present</td>
<td>22</td>
<td>Trent</td>
<td>168</td>
</tr>
</tbody>
</table>

HydroLogics unimpaired the streamflow data for ten gages, which are highlighted in bold in Table 1. The other gages are on rivers where impairments are negligible or not quantified.
The second step in the inflow development process is to fill in the missing flows and gains for each gage with missing records. This requires assembling a monthly record of unimpaired flows and gains based on the daily unimpaired data computed above. These flows and gains are fed into a program named *fillin* (developed by William Alley and Alan Burns of the USGS²). We will refer to these as “extended” flows and gains. This is done on a monthly basis because *fillin* only works with monthly data. The gages associated with the flows and gains used in the remainder of this document are shown in Table 2. The third step is to apportion the extended flows and gains to make sure that their volumes match downstream unimpaired gage flows. The monthly flows and gains are then disaggregated into daily values using local, unimpaired gages. These steps are described in detail in Section 3.

The last step in the process is to compute the OASIS nodal inflows based on the flows and gains computed above. This step is described in detail in Section 4.

Before undertaking these steps, we made some simplifications to certain gage records. On the

Little River, two major gages were combined into one. The gages near Orange Factory (reference Litor1) and SR1461 near Orange Factory (reference Litor2) are adjacent (drainage areas are 80.4 mi$^2$ and 78.2 mi$^2$, respectively). Between them, they have a complete but non-overlapping record going back to 1961. We scaled the Litor1 flows by 78.2 / 80.4 and treated the new flows as part of the Litor2 record, thus making one long record at Orange Factory (reference Litor).

The inflows to Durham’s Lake Michie and Little River Reservoirs are based on drainage area adjustments of the upstream Flat River at Bahama and the Little River near Orange Factory gages, respectively, and are given the name Michie and LitRes.

The records of the gages Little River near Princeton, Neuse River near Goldsboro, and Neuse River near Kinston all start in March 1930. We extended the record using fillin back to January 1930. These extensions were done prior to any of the work whose description follows.

<table>
<thead>
<tr>
<th>Gage</th>
<th>Flow or Gain</th>
<th>Gain Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hills</td>
<td>Flow</td>
<td></td>
</tr>
<tr>
<td>Durha</td>
<td>Gain</td>
<td>Durha flow – Hills flow</td>
</tr>
<tr>
<td>North</td>
<td>Gain</td>
<td>North flow – Michie flow – LitRes flow – Hills flow</td>
</tr>
<tr>
<td>Falls</td>
<td>Gain</td>
<td>Falls flow – North flow</td>
</tr>
<tr>
<td>Clayt</td>
<td>Gain</td>
<td>Clayt flow – Falls flow</td>
</tr>
<tr>
<td>Middl</td>
<td>Flow</td>
<td></td>
</tr>
<tr>
<td>Golds</td>
<td>Gain</td>
<td>Golds flow – Clayt flow – Middl flow – Litpr flow</td>
</tr>
<tr>
<td>Kinst</td>
<td>Gain</td>
<td>Kinst flow – Golds flow</td>
</tr>
<tr>
<td>Buckhorn</td>
<td>Flow</td>
<td></td>
</tr>
<tr>
<td>Hooke</td>
<td>Gain</td>
<td>Hooke flow – Buckhorn flow</td>
</tr>
</tbody>
</table>

Note that the gains at Clayton, Goldsboro and Kinston are calculated with consideration made to the time of travel (flow routing) along the Neuse. See Section 6 for more information.
Section 3. Computation of Extended Gage Flows and Reach Gains

All the computations outlined in this section are done on monthly data, which reduces noise and is required for statistical hydrology programs like fillin. Noisy data occurs when time of travel differences occur or when the impairment data create artificial variation in the flows.

First, the actual gains are determined from the unimpaired gage flows. These computations are done with the DSSVue script, compute_gain.py. Next, fillin is run to compute the extended flows and gains for the gages with missing records. Note that fillin preserves the actual flows and gains where they exist. These extended flows and gains are then “scaled.” The objective of scaling is to ensure that the sum of filled-in flows upstream of a gage with an actual record equals the actual unimpaired flow at that gage. The fillin program does not ensure this for two reasons. First, it utilizes only a single correlated record for each value generated, thus ignoring sums, and second, it works with log transforms, and not actual flows.

Here is an example. We want to compute the unimpaired flow at Hills and unimpaired gain at North from October 1961 to September 1981 when either the impairments at Hills cannot be quantified (and thus the gage cannot be unimpaired) or the Hills gage data are missing. As a result, we have no actual (unimpaired) flow at Hills and no actual gain at North. We extended the gage record at Hills and extended the gain at North using fillin. Now we want to adjust those extended values so that the sum of the flows at Hills, Michie, LitRes, and the remaining gain down to North match the unimpaired flow at North. So we say that we maintain the North flow less the inflows to Michie and LitRes by scaling with the sum of the Hills and the North extended gain. The calculation is:

\[
\text{Scaled North extended gain} = \frac{(\text{North flow} - \text{Michie flow} - \text{LitRes flow}) \times (\text{North extended gain})}{(\text{North extended gain} + \text{Hills extended flow})}
\]

The companion calculation for the flow at Hills is:

\[
\text{Scaled Hillsborough extended flow} = \frac{(\text{North flow} - \text{Michie flow} - \text{LitRes flow}) \times (\text{Hills extended flow})}{(\text{North extended gain} + \text{Hills extended flow})}
\]

Thus the sum of the actual unimpaired flows (Michie and LitRes) and the scaled flow (Hills) and scaled gain (North) equals the unimpaired gage flow at North.

In this way we ensure that the total volume of all the flows and gains, be they actual or extended, upstream from a given gage match the unimpaired flow at the gage, preserving the unimpaired gaged flows.

The DSSVue script used to do these calculations is scale_flow_gain.py. The output is the file scale_flow_gain.dss, which contains monthly flows and gains.
The next step is to disaggregate the monthly flows into daily flows. This is done using flows for a daily, unimpaired gage that is local or has similar drainage area (call it a “reference gage”) along with our monthly flows. We multiply the monthly value by the ratio of that day’s flow to that month’s flow at the reference gage. The disaggregation formula is:

\[
\text{daily ratio} = \frac{\text{daily reference value}}{\text{monthly reference value}} \\
\text{daily computed value} = \text{monthly computed value} \times \text{daily ratio}
\]

Two DSSVue scripts are used to do this step: *convert_month_to_day.py* and *disaggregate.py*. DSSVue cannot work on two records with different time steps, so the first step is to convert the monthly value to daily. For example, the gain at North for January 1930 is 156 cfs; converting the monthly flow to daily gives 156 cfs for each day in the month. The first script converts the monthly flows to daily flows for each location where we need them. The second script computes the daily flows and gains as shown above.

It is important to note that we are not trying to replicate history in computing the OASIS inflows; rather, we are trying to build daily flows whose variation is representative of history while preserving unimpaired gaged flows as “ground truth”.

Note that actual daily values of unimpaired gage flows are often maintained in the script files. Actual daily gains between gages are generally not maintained due to their “noise”, so the script files aggregate them monthly and then disaggregate them back to daily values using a locally unimpaired gage. The exception is Falls Lake post-project, when we are using the back-calculated inflows that are calculated daily. Large fluctuations in inflows can easily be handled by Falls Lake given its large amount of storage. Therefore, actual flows and gains on a monthly basis are maintained, but generally the former will only be maintained on a daily basis.

The remainder of this section shows the details in how the records were extended and disaggregated. This is the short hand used in the remainder of this document:

\[
\begin{align*}
\text{d/s} & = \text{downstream} \\
\text{u/s} & = \text{upstream} \\
\text{DA} & = \text{drainage area} \\
\text{F} & = \text{actual or scaled flow at a gage} \\
\text{XF} & = \text{“extended” flow at a gage as computed by fillin when actual flows do not exist} \\
\text{G} & = \text{actual or scaled gain, or inflow, between two locations, which is the difference of u/s gage F and d/s gage F} \\
\text{XG} & = \text{extended gain between two locations as computed by fillin when actual gains do not exist}
\end{align*}
\]
Eno River near Hillsborough FLOW (Hills), 10/28 – 9/71, 10/85 – present

This gage prior to 10/1954 is not influenced by reservoir operations, so it can be unimpaired. After that, reservoir data are only available from 8/1997 to present, meaning it must be filled in from 1955 to 7/1997. Note that we arbitrarily selected 1928 as the starting year, although we standardized the data set later to begin at the start of the 1930 decade.

10/28 – 09/54 use actual daily values
10/54 – 08/61 HillsF = (NorthF – MichieF) * HillsXF / (NorthXG + HillsXF + LitResXF)
11/80 – 07/97 use values generated by fillin
08/97 – 04/08 use actual daily values
Disaggregate 10/54 to 7/97 using Flatb.

Eno River near Durham GAIN (Durha), 10/28 – present

Hillsborough gage data are missing from 10/71 to 09/85

10/28 – 08/63 Hills F * 75 / 66 (drainage area adjustment of Hillsborough flow)
09/63 – 09/71 Durh F – Hills F + net withdrawal within reach
10/71 – 09/85 Hills F * 75 / 66 (drainage area adjustment of Hillsborough flow)
10/85 to present Durh F – Hills F + net withdrawal within reach

Gain included in script files since disaggregation of full record is required. Disaggregate whole record with Flatb.

Little River FLOW (09/61 – present)

10/54 – 08/61 LitResF = (NorthF – MichieF) * LitResXF / (NorthXG + LitResXF + HillsXF), disaggregate with Flatb
09/61 – present Use actual daily values.

Neuse River near Northside GAIN (North), 10/1928 – 10/1980

10/28 – 09/54 NorthG = (NorthF – MichieF – HillsF) * NorthXG / (NorthXG + LitResXF)
10/54 – 08/61 NorthG = (NorthF – MichieF) * NorthXG / (NorthXG + LitResXF + HillsXF)
09/61 – 10/80 NorthG = (NorthF - MichieF - LitResF) * NorthXG / (NorthXG + HillsXF)
11/80 – 04/81 use values generated by fillin
Disaggregate whole record with Flatb

Beginning May 1981, we no longer need Northside gains since we are using back-calculated inflows from Falls.

Neuse River near Falls GAIN (North), 07/1970 – 06/1976

9
Computed gain at Falls is FallsF – NorthF
10/28 – 06/70 use values generated by fillin
07/70 – 06/76 FallsG = FallsF – NorthF
7/76 – 04/81 use values generated by fillin
Disaggregate whole record with Flatb

Flows after this are done with a spreadsheet to compute the daily gain to Falls, which represents the difference between the back-calculated Falls inflow [unimpaired] and upstream inflow [unimpaired]).

Neuse River near Clayton GAIN (Clayt), 10/28 – present
10/28 – 4/81 ClaytonG = ClaytonF – (NorthF + FallsG)
5/81 – present Clayton G = ClaytonF (gage flow) – Falls release + local impairments in this reach
Disaggregate whole record with Litpr.

Neuse River near Goldsboro GAIN (Golds), 03/30 – present (filled in back to 1928)
Computed gain at Golds is GoldsF – ClaytF – LitprF - MiddlF
10/28 – 09/39 GoldsG = (GoldsF – ClaytF – LitprF) * (GoldsXG) / (GoldsXG + MiddlXF),
10/39 – present GoldsG = GoldsF – ClaytF – LitprF - MiddlF
Disaggregate whole record with Litpr.

Middle Creek near Clayton FLOW (Middl), 03/30 – present (filled in back to 1928)
10/28 – 09/39 MiddlF = (GoldsF – ClaytF – LitprF) * (MiddlXF) / (GoldsXG + MiddlXF),
10/39 – present Use actual daily values

Neuse River near Kinston GAIN (Kinst), 03/30 – present (filled in back to 1928)
10/28 – present KinstG = KinstF – GoldsF, disaggregate with Litpr

Buckhorn Reservoir FLOW (Buckhorn), 10/64 – present
Based on the drainage area adjustment of the Lucama gage, whose record does not start until 10/1964 and whose record is impaired by the reservoir operations since 10/1974.
10/28 – 09/64 BuckhornF = HookeF * (BuckhornXF) / (HookeXG + BuckhornXF),
10/64 – 09/74 Use actual daily values
10/74 – present BuckhornF = HookeF * (BuckhornXF) / (HookeXG + BuckhornXF),
Disaggregate with Litpr

Contentnea Creek near Hookerton GAIN (Hooke), 12/28 - present
Computed gain at Hooke is HookeF – BuckhornF
10/28 – 09/64 HookeG = HookeF * (HookeXG) / (HookeXG + LucamXF)
10/64 – 09/74 HookeG = HookeF - BuckhornF
10/74 – present HookeG = HookeF * (HookeXG) / (HookeXG + LucamXF)
Disaggregate whole record using Litpr

The result of the computations in this section is a set of monthly and daily flows and gains at each of the locations shown in Table 2.
Section 4. Computing Inflows at OASIS Nodes from the Flows and Gains

This section describes the computation of inflows at OASIS nodes from flows and gains at gages described above. The computations are done “on the fly” during an OASIS run called “Compute_Inflows” using ratios of drainage area (total or incremental) as shown in Table 3. The computations are included in an OCL file called set_inflows.ocl and are listed below.

Node 010 (u/s Orange pond)  Hills Flow * 7.1 / 66
Node 050 (WFER)  Hills Flow * 9.4 / 66
Node 060 (Lk Orange)  Hills Flow * 1.8 / 66
Node 080 (Corporation Lk)  Hills Flow * 22.9 / 66
Node 100 (Lk Ben Johnston)  Hills Flow * 19.2 / 66
Node 110 (Hills gage)  Hills Flow * 5.6 / 66
Node 115 (Durha gage)  Durha Gain
Node 140 (Lk Michie)  Michie Flow
Node 200 (Little River Res)  LitRes Flow
Node 250 (Lk Holt)  Inflow200 * 30 / 97.7
Node 270 (Lk Rogers)  Inflow200 * 17.4 / 97.7
Node 230 (Beaverdam Lk)  (North Gain + Falls Gain – Inflow115 – Inflow250 – Inflow270) * 0.05 prior to 5/1981

[The Corps assumes 5% of the total inflows to Falls and Beaverdam are allocated to Beaverdam, even though the proportion would be a bit different on a drainage area basis. The remaining 95% is allocated to Falls.]

See below for 5/1981 to present

Node 290 (Wake Forest Lk)  Middl Flow * 3 / 83.5
Node 300 (Falls Lk)  (North Gain + Falls Gain – Inflow115 – Inflow250 – Inflow270)) * 0.95 prior to 5/1981

See below for 5/1981 to present

Node 400 (Lk Crabtree)  Middl Flow * 93.7 / 83.5
Node 420 (Lk Wheeler)  Middl Flow * 35.8 / 83.5 prior to 03/2002; Swift Flow * 35.8 / 21 from 03/2002 – present
Node 440 (Lk Benson)  Middl Flow * 30.5 / 83.5 prior to 03/2002; Swift Flow * 30.5 / 21 from 03/2002 – present

12
Node 445 (Lk Johnson)  Middl Flow * 7.1 / 83.5
Node 450 (Lk Raleigh)  Middl Flow * 5.2 / 83.5
Node 480 (Middl gage)  Middl Flow
Node 500 (Buckhorn Res)  Buckhorn Flow
Node 560 (Hookerton gage)  Hooke Flow - Buckhorn Flow
Node 630 (Clayton gage)  Clayt Gain – Inflow290 - Inflow400 – Inflow445 – Inflow450
Node 740 (Little River Res)  Litpr Flow * 51.8 / 232
Node 750 (Litpr gage)  Litpr Flow * 179 / 232
Node 780 (Goldsboro gage)  Golds Gain – Inflow420 - Inflow440
Node 800 (Kinst gage)  Kinst Flow – Golds Flow
Node 900 (Weyerhauser)  Weighted average cfsm based on Kinst Flow and Contentnea Creek * Incremental drainage area

Node 230 (Beaverdam) and node 300 (Falls Lake) inflows require extra computations once the dam was built. Post-project, the gain at Falls is computed by back-calculating the inflows from the Falls release and the change in storage, with the net evaporation added back. Since the Corps inflows include Beaverdam storage only when Falls is at or above 249 ft, we need to increase these inflows for those periods when Beaverdam was below 249 ft. We proportion 5% of the total Falls inflow to Beaverdam, so we divide the Falls/Beaverdam inflow by 0.95 to achieve this. The back-calculated inflows are impaired due to upstream impairments, so we need to take these into account. To get agreement with the total unimpaired flow at Clayton, we must account for the same impairments.

05/1981 – present

If Beaverdam elev < 249
(Corps net inflow + net evap) / 0.95 – Hills Flow - Inflow115 – Inflow140 – Inflow200 - Inflow250 – Inflow270 + total impairment from net withdrawals and reservoirs upstream of Falls Lake (including those on the Eno and from Durham’s reservoirs).

If Beaverdam elev >= 249
(Corps net inflow + net evap) – Hills Flow - Inflow115 – Inflow140 – Inflow200 - Inflow250 – Inflow270 + total impairment from net withdrawals and reservoirs upstream of Falls Lake (including those on the Eno and from Durham’s reservoirs).

The final inflow to node 300 (Falls) is 95% of the above calculations, after proportioning 5% to Beaverdam (node 230).
### Table 3. List of Drainage Areas (in square miles)

<table>
<thead>
<tr>
<th>Reservoirs</th>
<th>Total Drainage Area</th>
<th>Incremental Drainage Area</th>
<th>Gages</th>
<th>Total Drainage Area</th>
<th>Incremental Drainage Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orange Impoundment</td>
<td>7.1</td>
<td>7.1</td>
<td>Eno River at Hillsborough</td>
<td>66</td>
<td>5.6</td>
</tr>
<tr>
<td>West Fork Eno Reservoir</td>
<td>9.4</td>
<td>9.4</td>
<td>Eno River nr Durham</td>
<td>141</td>
<td>75</td>
</tr>
<tr>
<td>Lake Orange</td>
<td>8.9</td>
<td>1.8</td>
<td>Neuse River at Clayton</td>
<td>1150</td>
<td>380</td>
</tr>
<tr>
<td>Corp. Lake</td>
<td>41.2</td>
<td>22.9</td>
<td>Little River nr Princeton</td>
<td>232</td>
<td>179</td>
</tr>
<tr>
<td>Lake Ben Johnston</td>
<td>60.4</td>
<td>19.2</td>
<td>Neuse River at Goldsboro</td>
<td>2399</td>
<td>933.5</td>
</tr>
<tr>
<td>Lake Michie</td>
<td>167</td>
<td>167</td>
<td>Contentnea Cr at Hookerton</td>
<td>733</td>
<td>578</td>
</tr>
<tr>
<td>Little River Reservoir</td>
<td>97.7</td>
<td>97.7</td>
<td>Neuse River at Kinston</td>
<td>2692</td>
<td>293</td>
</tr>
<tr>
<td>Lake Holt_Butner</td>
<td>30</td>
<td>30</td>
<td>Middle Creek near Clayton</td>
<td>83.5</td>
<td>83.5</td>
</tr>
<tr>
<td>Lake Rogers</td>
<td>17.4</td>
<td>17.4</td>
<td>Swift Creek near Apex</td>
<td>21.0</td>
<td>21.0</td>
</tr>
<tr>
<td>Beaverdam Lake</td>
<td>50</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Falls Lake</td>
<td>770 (751)</td>
<td>439 (420)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wake Forest Lake</td>
<td>3</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lake Crabtree</td>
<td>93.7</td>
<td>93.7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lake Wheeler</td>
<td>35.8</td>
<td>35.8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lake Benson</td>
<td>66.3</td>
<td>30.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lake Johnson</td>
<td>7.1</td>
<td>7.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lake Raleigh</td>
<td>12.3</td>
<td>5.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Buckhorn Reservoir</td>
<td>155</td>
<td>155</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Little River Reservoir (Raleigh proposed)</td>
<td>51.8</td>
<td>51.8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weyerhaeuser</td>
<td>4103</td>
<td>678</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Value in parentheses is net of surface area of lake at full pond
Section 5. Inflow Filtering

As noted in Section 3, because of the noisy data, a lot of error checking is necessary. These are some of the errors that can occur.

- Negative unimpaired gage flow. These are physically impossible and should be corrected.

- Negative gains. These are sometimes legitimate. However, there are times when a flood hits a gage at the very end of the month, while not arriving at the gage downstream until the beginning of the next month. This can cause a highly negative gain in the first month and a highly positive gain the next month. These should be corrected. Addressing time of travel along the main stem of the Neuse (see Section 6) reduces the number of months when this occurs.

To prevent model infeasibility, unrealistic releases from upstream reservoirs, or unrealistic water supply shortages, we added code in the OCL to filter these negative inflows. The negative inflow is “stored” until there is a sufficiently positive inflow to release the accumulated negative flows, thereby preserving mass over a multi-day period. Since the negative inflows are generally very small and infrequent, the filtering has negligible impact on being able to match the monthly unimpaired gage flow.
Section 6. Time of Travel / Flow Routing

To account for time of travel between points along the main stem of the Neuse River, flow routing has been incorporated into both the development of inflows, and the handling of flows within the model. The time of travel or lag coefficients were furnished by the Corp of Engineers. The time of travel reaches consist of the Falls dam to the Clayton gage, the Clayton gage to the Goldsboro gage, and the Goldsboro gage to the Kinston gage. Flow routing for the development of inflows is handled in the HEC-DSSVue script called `routing.py`. Flow routing within the model is handled in the OCL file `routing.ocl`. The routing equations used for each gain are as follows:

Clayton gain = Clayton flow - 2 day average of Falls releases  
Routed Falls release = 0.5*yesterday’s release + 0.5*today’s release

Goldsvoro gain = Goldsboro flow - previous four day average of Clayton flows  
Routed Clayton Flow = \[ \frac{flow(-4 \text{ days}) + flow(-3 \text{ days}) + flow(-2 \text{ days}) + flow(-1 \text{ day})}{4} \]

Kinston gain = Kinston flow - previous two day average of Goldsboro flows  
Routed Goldsboro Flow = \[ \frac{flow(-2 \text{ days}) + flow(-1 \text{ day})}{2} \]

Note that the computation of gains may include subtracting the flows from tributaries in the reach (see Section 3), which are not routed.
Section 7. Extending the Record Beyond April 2008

As mentioned earlier, the finalized inflow record ends on April 30, 2008. This section describes how to finalize updates to the record when new records (including impairments) become available. This is not to be confused with provisional updates used to facilitate real-time forecasting, which are done directly from the model interface using the Update Record tab. Let us assume that we are adding data from May 1, 2008 to September 30, 2008. Note that we are only adding to the record. We are not changing any of the values prior to May 2008.

1. Assemble the new gage records in Table 4 and place in the files gage_day.dss and gage_month.dss. Note that the Flatb and Litor gage flows need to be adjusted by drainage area to the Lake Michie and Little River Reservoir drainage areas, respectively, before being entered into gage_day.dss and gage_month.dss under the appropriate reservoir names.
   Note that the local upstream impairments for the Clayton gage need to go into the gage_day.dss and gage_month.dss files.

2. Compute the impairments at each gage and add them to the gage flows. This has been done in the unimpairment spreadsheets described earlier. Append the new unimpaired flows to the unimpaired.dss file (monthly averages) and to the unimpaired_daily.dss file (daily data) where appropriate. Note that the unimpaired Little River at Princeton gage needs to be appended into the gage_day.dss and gage_month.dss files, and the daily unimpaired Eno River at Hillsborough and Middle Creek nr Clayton gage flows need to go into the gage_day.dss file (with “Unimpaired” in the F-part) in addition to the monthly flows going into the unimpaired.dss file.

3. Copy the following files into the folder c:\Program Files\HEC\HecDssVue (assuming the DSSVue has been installed in the default location).
   fillin.cf
   fillin.exe
   gage_day.dss
   gage_month.dss
   path_list.dat
   unimpaired.dss
   unimpaired_daily.dss

4. Copy the following files in folder of c:\Program Files\HEC\HecDssVue\HecDssVue\scripts. The script files must be modified such that the ending month of the record from “apr” to “sep”. If extending the record to a year beyond 2008, be sure to change the ending years in the script from 08 or 2008 the appropriate year. Use the script files from the folder “scripts_2008”, in which this change has already been made.
   routing.py
   compute_gain.py
   convert_day_to_month.py
5. Open up DSSVue. From the Script Browser (under the Utilites menu), execute the script 01_routing.py (note the number indicates the order in which the script files should be used) by clicking File → Test while the script is selected. This reads from file unimpaired_daily.dss, routes the flows on the main stem Neuse according to the time of travel specified in section 6, and writes the monthly averages to the files unimpaired.dss and gage_month.dss.

6. Execute the script 02_compute_gain.py. This reads from file unimpaired.dss, computes all the gains, and writes to the files extend_flow_gain.dss, scale_flow_gain.dss, and fillin_input.dss.

7. Close DSSVUE, and execute fillin by double-clicking it. This updates the file extend_flow_gain.dss with filled-in flows. Thus, this file is a combination of the actual unimpaired values and extended values.

8. Open up DSSVue again, execute the script 03_scale_flow_gain.py, which does the calculations described in Section 3. This reads from file extend_flow_gain.dss and updates file scale_flow_gain.dss.

9. Execute the script 04_convert_month_to_day.py. This reads from files gage_month.dss and scale_flow_gain.dss to generate a daily record from the monthly records. The daily records are used to disaggregate the flows, as shown in Section 3. File month_day.dss is written.

10. Execute the script 05_disaggregate.py to convert the monthly flows and gains at the gages to daily. File flow_gain.dss is produced; this file has the data that are read by OASIS.

11. Execute the script 06_convert_day_to_month.py to convert the daily flows and gains at the gages into monthly values. The purpose of this step is to import the monthly flows and gains into gage_comp.xls to ensure that all the accounting has been properly done. Note that the time series for the monthly Falls inflow (see #12) also needs to be entered into the gage_comp.xls in order to reconstitute the Clayton unimpaired gage flow.

12. Once the correct accounting has been confirmed, copy the updated Falls Lake net inflow record the unimpairment spreadsheet file and append into the new flow_gains.dss file through September 30, 2008 (under the Falls_Bdam/Flow record). Place this flow_gains.dss file into the basedata folder, overwriting the original.

13. Copy the Swift Creek nr Apex USGS gage record into the flow_gains.dss to append the Swift/Flow record starting on May 1, 2008.

14. In order for the Compute Inflows OASIS run to work, Falls/Gain and North/Gain records need to have zeros entered for May 1, 2008 through September 30, 2008. The run does not use these
records post Falls Lake project (1981), but still requires a “dummy” value to be present in order to execute the run.

15. Execute the OASIS run called “Compute_Inflow”, beginning May 1, 2008 and ending September 30, 2008. This run contains a file called “set_inflows.ocl” that assigns inflows to the OASIS nodes. Then go to the run folder, open the output.dss file, click View ➔ Refresh Catalog. Select all of the inflow nodes (i.e, those which have a pathname labeled inflow) and convert from acre feet (af) to cubic feet per second (cfs) by doing the following: click Utilities ➔ Math Functions, in Arithmetic tab select Divide from the pull down menu, click the Data Set radio button and highlight all of the inflow records, click the Constant radio button and enter 1.9835 into the field, and then press the Compute button at the bottom of the window. Once the computation has completed, close the Math Functions window and click Yes when prompted to save the changes. Now select all of the inflow records and click Edit ➔ Tabular Edit, and change all of the units to cfs, and all of the units Type to PER-AVER. Close the editing window and save your changes. Next select all of the records, and copy and append to the basedata.dss file in the basedata folder. The basedata file will now contain this finalized data from May 1, 2008 to September 30, 2008. This basedata file will be used for all future runs.
Table 4. Gages Used to Extend the Record Beyond April 2008

<table>
<thead>
<tr>
<th>USGS Number</th>
<th>Description</th>
<th>Period of Record</th>
<th>Ref. Name</th>
<th>Drainage Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>02085000</td>
<td>Eno R. at Hillsborough</td>
<td>10/1927-9/1971, 10/1985-present</td>
<td>Hills</td>
<td>66</td>
</tr>
<tr>
<td>02085070</td>
<td>Eno R. nr. Durham</td>
<td>09/1963-present</td>
<td>Durha</td>
<td>141</td>
</tr>
<tr>
<td>0208521324</td>
<td>Little R. at SR1461 nr. Orange Factory</td>
<td>10/1987-present</td>
<td>Litor2</td>
<td>78.2</td>
</tr>
<tr>
<td>02085500</td>
<td>Flat R. at Bahama</td>
<td>7/1925-present</td>
<td>Flatb</td>
<td>149</td>
</tr>
<tr>
<td>02087183</td>
<td>Neuse R. nr. Falls</td>
<td>7/1970-present</td>
<td>Falls</td>
<td>771</td>
</tr>
<tr>
<td>02087500</td>
<td>Neuse R. nr. Clayton</td>
<td>7/1927-present</td>
<td>Clayt</td>
<td>1150</td>
</tr>
<tr>
<td>02087580</td>
<td>Swift Ck. nr. Apex</td>
<td>3/2002-present</td>
<td>Swift</td>
<td>21</td>
</tr>
<tr>
<td>02088000</td>
<td>Middle Ck. nr. Clayton</td>
<td>10/1939-present</td>
<td>Middl</td>
<td>83.5</td>
</tr>
<tr>
<td>02088500</td>
<td>Little R. nr. Princeton</td>
<td>2/1930-present</td>
<td>Litpr</td>
<td>232</td>
</tr>
<tr>
<td>02089000</td>
<td>Neuse R. nr. Goldsboro</td>
<td>2/1930-present</td>
<td>Golds</td>
<td>2399</td>
</tr>
<tr>
<td>0208925200</td>
<td>Bear Ck. at Mays Store</td>
<td>10/1987-present</td>
<td>Bearc</td>
<td>57.7</td>
</tr>
<tr>
<td>02089500</td>
<td>Neuse R. at Kinston</td>
<td>2/1930-present</td>
<td>Kinst</td>
<td>2692</td>
</tr>
<tr>
<td>02091000</td>
<td>Nahunta Sw. nr. Shine</td>
<td>4/1954-present</td>
<td>Nahun</td>
<td>80.4</td>
</tr>
<tr>
<td>02091500</td>
<td>Contentnea Ck. nr. Hookerton</td>
<td>12/1928-present</td>
<td>Hooke</td>
<td>733</td>
</tr>
<tr>
<td>02091700</td>
<td>Little Contentnea Ck. nr Farmville</td>
<td>10/1956-9/1987</td>
<td>Ltcon</td>
<td>93.3</td>
</tr>
</tbody>
</table>